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Chapter One

Safety



Introduction to
Safety

Electrical Safety

Read, understand and follow the safety precautions prior to power-up or
operation of this system to avoid injury and prevent damage to the
MicroMill Sampling System or any interfacing devices. Use the system
only as specified in this manual.

Follow the instructions and precautions in this manual for proper
installation and safe operation of this tool.

e Consult ANSI, (American National Standards Institute), ACGIH
(American Conference of Industrial Hygienists) and OSHA
(Occupational Safety and Health Administration) standards for
safety guidance.

WARNING: The MicroMill Sampling System contains internal components
that present severe electrical hazards. Improper operation or servicing
can result in death, personal injury or material damage. Only qualified
personnel should operate or service this equipment.

The MicroMill Sampling System presents numerous health and safety hazards.
These dangers include but are not limited to:

e Fire Danger from Electrical Components.

e Electrical Shock Hazard.

The MicroMill Sampling System meets Conforité European (CE) safety
and emission standards.

There are no user serviceable electrical parts in the MicroMill Sampling
System. New Wave Research must conduct any service procedures. General
rules of electrical safety must be followed at all times.



Installation and Setup

Safety Features The following safety features are incorporated into the MicroMill Sampling
System and conform to government regulations to provide safe operation.

System Housings The MicroMill Sampling System is enclosed in a protective housing that
limits exposure to dangerous electrical hardware. This cover should be
removed only by New Wave trained personnel performing periodic
maintenance or repair.

Interlocks Never disable or defeat an interlock. The MicroMill Sampling System is
equipped with the following interlocks which prevent operation in specific
unsafe conditions:

Sample Slide Interlock
Cause: The sliding stage that the sample is mounted on is not in the
Drill position (all the way to the left). It is normal for this interlock to be
activated when the sample is in the microscope view position.
Result: The drill is disabled. The video view is switch to the
microscope when the slide is not in the Drill position, and is switched
back to the drill video when the slide is returned to the Drill position.
Drill Overload Interlock
Cause: The drill motor current limit has been exceeded.
Result: The drill is disabled.
Drill Z Sensor Interlock
Cause: The drill has moved up (vertically) due to pressure on the bit.
Result: The drill is disabled.
Stop Button Interlock
Cause: The Stop button (on the front of the MicroMill Sampling
System) has been pressed.
Result: The drill and stages are disabled. You need to press the Stop
Button indicator on the Interlock Failure window to clear the indicator
and re-enable the stages and drill.
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Chapter Two

System
Description



System
Overview

Hardware

Software

This section describes the installation and use of New Wave Research
Products MicroMill Sampling System software. The MicroMill Sampling
System is a solid sampling system that uses a drill mounted on a video
microscope assembly and a set of motorized stages to precisely drill
and mill samples.

A MicroMill Sampling System is a special video microscope mated with
a high-speed drill and a set of computer-controlled motorized stages.
The sample to be milled is mounted on top of the stages so that it can
be positioned underneath the microscope. Two computer-controlled
light sources are included -- a reflected light and a transmitted light
source. The drill is mounted off to the side of the microscope, so a
special sliding sample holder is used to shuttle the sample back and
forth between the drill position and the microscope position. A video
camera is mounted on the microscope to send an image of the
microscope view to the computer; another video camera is mounted
near the drill to monitor the milling procedure.

¢ Runs on Intel-compatible PC computers using the Windows
98°, 2000, NT, ME and XP operating systems.

e Is used to control the drill, lights, stages, monitor safety
interlocks and automate record and monitor the milling process.

e Is a 32-bit application completely written in object-oriented
Pascal using Borland Delphi.

e Based on a point-and-click interface, where the live video
image of the sample is displayed in a window on the computer
monitor, with crosshairs on the image to show where the drill is
aimed.

See Minimum System Requirements on page 8 for information on what you
need to run the software.
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Chapter Three

Installation and
Setup



Installing the The CD supplied with the system will guide you through the Software

Software Setup. If you have any questions or problems, please contact New Wave
Research.

Minimum System  Operating System - Windows 95/98©, or Windows NT©

Requirements Computer — Pentium 300 MHz or faster.

Display -- 800x600

To get live video, you must have the Imagination PXC card and drivers
installed in your system. At the time of this writing, you must also set the
computer's display to 24-bit color mode (True Color) for live video to work.

Unpacking and Setup Instructions

Computer

Computer purchased with MicroMill Sampling System
If you purchased a computer with your MicroMill Sampling System, then it has
already been configured and had the necessary software installed. Simply
unpack the system following the computer manufacturer’s instructions, and setup
and boot the computer. If your system was supplied with Windows NT, there is
no password required — leave the password entry blank and press Enter. (You
can change the password later if you'd like.)

Computer supplied separately
If you did not purchase a computer with the MicroMill Sampling System, then you
will need to install the live video overlay board in the computer, and install the
MicroMill Sampling System software.
In the MicroMill Sampling System accessories box you will find the video capture
card, a CDROM containing the necessary software drivers and manuals, which
explains how to install the card.

Note: where the manuals refer to floppy disks, you should use the appropriate
directory on the supplied CDROM instead. You will need to install the appropriate
display driver for your operating system.

The MicroMill Sampling System accessories box also contains a floppy disk
containing the MicroMill Sampling System initialization files.

These files must be copied into the MicroMill program directory. The initialization
files contain the calibration information created when the system was
manufactured and set up at the factory.



Controls and Operations

MicroMill
Follow the instructions below to unpack and assemble the MicroMill Sampling

System.

1) Remove the MicroMill from the packing crate. In the crate you will find the
main mill chassis, the video camera assembly, and the accessories box.

2) Remove the mill chassis and the video camera from their packaging
material. Remove the black cap covering the video port on the top of the
microscope, and install the camera assembly; being careful to orient the
camera as shown, with the camera serial number label towards the front
of the mill. Lightly tighten the camera on the top of the microscope video
port to hold the camera in place. You will need to align the camera later.

3) REMOVE STAGELOCKS. You will need to remove all 4 screws holding the
stage locks in place (2 per axis). Moving the stages with the locks in
place will damage the stages!

{

2

Figure 3-1: X and Y stage locks

4) Find the microscope eyepieces in the accessories box and install them in the
microscope.

5) Remove the cables from the accessories box and connect to the MicroMill
Sampling System to the computer. Connect the RS232, the SVIDEO,
and the Drill Video cables to the appropriate connector on the computer.
Connect the power cord to the system.

6) Power up the computer and the MicroMill Sampling System, then run the
MicroMill Sampling System software — the software will perform a
system self-test and verify that all the components of the system are
functioning.



7) Perform the alignment checks and procedures on the following
pages.

Figure 3-2: Attaching camera after removing from accessory box.

8) Screw camera onto video port located on top of the Microscope head. The
serial number label on the camera should be facing towards the user.
Once this is done, the camera should need only nominal alignment.
Parfocal and confocal adjustments may need nominal alignment. The
stage to camera alignment should be the only one needing adjustment.
You can achieve this alignment by referring to the section Aligning the
Microscope Video with Stages on page 12.

10
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Microscope Video Parfocal Adjustment

In order for the video camera mounted on the microscope and the microscope
eyepieces to both be in focus at the same time, it is necessary to adjust the focus
of the video relay lens, located on the microscope video adapter as shown in
Figure 3-3. This adjustment is made at the factory prior to shipping, but you may
wish to double check it to make sure it hasn’t moved during shipment.

Parfocal Adjustment screw x2

o
<
2z,

L".—\.-\.ﬁ = P

Figure 3-3: Parfocal Adjustment Screws

Performing the Adjustment:

1) Place an object under the microscope and turn up the illumination. Move the
Z axis up or down until the view through the microscope eyepieces is in
focus when zoomed in and zoomed out.

2) Zoom the microscope all the way in, and then look at the microscope video
on the computer screen. You may have to slide the video source
selector rod in and out on the side of the microscope to view the desired
image. If it is not in focus, then you will need to loosen the video relay
lens adjustment screws and rotate the assembly until the video is in
focus. Rotating the assembly will raise or lower the camera position to
attain parfocal. Zoom the microscope all the way out and check the
focus. Adjust the lens until the video remains in focus when zoomed in
and out. Tighten the lens adjustment screws.

11



Aligning the Microscope Video with Stages
In order for the drill to accurately track any scans you place on the video screen
using the mouse, the video must be aligned with the stages. Since the MicroMill
Sampling System is shipped with the camera assembly removed from the unit, it
is necessary to perform this alignment when first setting up the system.

NOTE: When the camera is properly aligned, it will appear to be rotated slightly
with respect to the front of the MicroMill -- this is because the optical axis of the
camera port on the back of the microscope is at a slight angle.

Checking Alignment
1) Alignment is checked by focusing on a distinct point on the sample or on the

sample plate itself. Find a feature that is easily recognizable and move
the stages to position the feature so that it is centered over the
horizontal crosshair on the left side of the screen.

2) Move the X stage only until the spot is on the right side of the screen. The
spot should still be centered on the horizontal crosshair; if it isn't then
you need to adjust the camera alignment. You should check the
alignment at both 100% zoom (zoomed in) and 0% (zoomed out).

1. Position Spot Here...
"4

7

2. Move X Stage to
Put Spot Here.

Figure 3-4: Spot alignment

Video
Misaligned

: Les

Figure 3-5: Video misalighed

12
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Adjusting To adjust the alignment, locate the camera set screws on the sides of the
Alignment

Figure 3-6: Camera set screw

Loosen the set screw slightly (typically about half a turn is enough) -- if you
loosen it too much the camera will not be held in place firmly enough, making it
difficult to do the alignment. The camera can now be rotated by grabbing onto the
body of the camera and twisting it slightly. Repeat the alignment test and make
slight adjustments to the camera rotation until the video is aligned.

Re-tighten the set screw, being careful not to let the camera rotate.

13



Microscope The confocal adjustment is done to insure that the microscope video remains
Video Confocal centered on the same position regardless of the zoom position. This
Adjustment adj_ustment |s_made at the facto_ry, but you may wish to check it. To check the

adjustment, simply focus the microscope on a small feature, then move the
stages to center the feature on the video crosshairs, then zoom the
microscope in and out and see if the feature remains centered on the
crosshairs. If it does not, then you will need to adjust it by adjusting the set
screws shown below.

Performing the 1) Zoom the microscope all the way in and focus on a small feature. Move the X
Adjustment and Y stages to center the feature on the video crosshairs.

2) Zoom all the way out. If the feature does not remain centered, then center it up
by loosening and tightening the adjustment set screws (qty 3) until the feature
is centered on the crosshairs. Alternately loosen and tighten the opposing
screws to translate the image.

3) Repeat steps 1 and 2, making small adjustments each time, until the crosshairs
remain centered on the same location at any zoom level.

Figure 3-7: Confocal Adjustment Screws

14
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Chapter Four

Controls and
Operations
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Starting the
Software

Startup Screen

System
Information Panel

Tip

Installed Devices
Check

To run the software, make sure the MicroMill is powered on and
connected to the computer.

Click Start >Programs ->Merchantek EO-> MicroMill icon.

The software will then begin its startup sequence and display the Startup
screen.

The startup screen displays a graphic on the left and the system
information panel on the right.

MicroMill System
ersion: 1.1.1.1

Spstem Recurements:

B B Screen Resolalion 2 laast S00ME00
B Mease Presant

B Calor Aesclubon

Davices Inkalized

B Swstem Carboller
B Ol Cardiodler

B = b Cortialer

B iz Coricller

B Z fuis Corvioller

B Rirg Light Conlraler

Done, Press <Esc bo aboit, any key o conbrmee. .
Figure 4-1: Splash Screen

To the right of the splash screen is the MicroMill information panel. This is
a list of required hardware to run the program. If the computer does not
meet any of the system requirements, an error message is displayed and
the program terminates.

The software must have one serial port to communicate with the MicroMill
Sampling System.

If you encounter an error make sure that any software that might use a
serial port is not running. Serial ports are often referred to as COM1,
COM2 etc...

After the Splash Screen is displayed, the software will check for attached
devices. As each device is found and initialized, the name of the device is
displayed.

Following is a list of what the software will search for in the order in which
it will search:

1) System controller. The System controller communicates what
options are installed (light sources, Z axis etc..) This memory is
configured at the factory and is non-volatile (it retains its
contents even when power is not present).

2) Stage motor controller.

3) Light sources and any other options.

A check mark will appear in the box to the left of each found device name.
If a device fails initialization, an error message is displayed -- the software
will continue to run, but that device will be disabled.

Once the system startup sequence is complete, the main program
window is displayed.

16
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Setting up the

Software

Main Program
Window

Setup Checklist

The main program window is the "home" for most operations in the
MicroMill Sampling System software. It is divided into several sections.

B Meiohand ik BN - MassHRl

Gla Yuw Paron [rliskm Hep

| o | emsees o :
B | Lol zeiy ~ | ([7 e & 00 WOPECH B R
P | wec sl | AR
D] Patie
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P e e ]
Bl b =
- =
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Figure 4-2: Main Program Window

The major elements of the main window are:
e Setup Checklist

Live Video Display Window

Light Source Toolbar

Stage Scroll Bars

Stage Position Toolbar

Drill Controls

Scan Pattern Toolbar

Each of these elements is described in the following sections.

To properly position the drill and the sample, define scans and display the
video correctly, the MicroMill Sampling System software must know
certain information about the hardware. Most of this information is
obtained by running special setup and calibration procedures.

Each time you run the software, the Setup Checklist will be displayed in a
"floating” window, showing you what system setup procedures have been
done. By working through the procedures in the order indicated on the
checklist, you know the system is setup properly. To run a procedure,
click on the corresponding button in the checklist.

17



Setup Checklist |

Sy stem setup checklist by

¢ Stages Calibrated

— System Calibration

© 1. Zoom Sensor
© 2. Focal Plane

@ 3 Video Screen
o 4 Dl £ Sensor
© B, Drill = Offset

— Before Doing Scans
@ 1. Drill Bit Pozitiohed
@ 2 Sample Thickness

Cloze |

Figure 4-3: Setup Checklist screen

Status Indicators = Some procedures only need to be done once; others must be done each
time you run the system. An indicator next to each item provides a visual
cue of the status of that item. The indicator will show:

e "Grayed Out" or Disabled - the procedure cannot be done at
this time because the prerequisite procedure has not run.

e Blue - the procedure has not been done. Click on the button to
activate the procedure.

o Dark Green - indicates that the procedure has been done but
it is waiting on another procedure to be complete. Some
procedures have prerequisites that must be done first -- for
example, the stages must be calibrated before the Drill XY
offset can be determined.

o Light Green - the procedure has been performed, and all
dependent procedures are done.

The checklist is divided into sections; each section contains items that are
logically grouped together according to when and how often the
procedures must be performed. Items in the System Calibration section
only need to be performed when:

e The system is first set up

e Something in the hardware has changed

e The system has been subjected to strong vibrations (due to

begin transported or knocked over etc...).

Note that the stage calibration procedure is a prerequisite to almost all of
the other procedures.

18
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Setup Toolbar

System
Calibration

Zoom Sensor

You can also access various system setup options by clicking on buttons
in the Setup Toolbar:

Y9 v
Figure 4-4: Setup Toolbar

The three buttons on the toolbar are, in left-to-right order:
o Drill Bit Position button - activates the procedure for loading
a new bit, and/or determining the position of the bit tip.
e Sample Thickness button - activates the procedure for
measuring the sample thickness.
o Checklist button - toggles the display of the system checkilist
on and off.

Some procedures only need to be done when the system is being set up
for the first time, or when the hardware has been changed. These are
grouped in the System Calibration section of the Setup Checkilist:

e Zoom Sensor - a sensor mounted inside the microscope used
to determine the position of the zoom optics. Used to
adjust the graphics on the microscope video display to the
proper scale.

e Focal Plane - defines the focal plane of the microscope. Used
to place the sample in focus under the microscope.

e Video Screen - defines the scaling between distance (in
pixels) on the microscope video display window and the
actual distance (in microns or millimeters) on the sample.
The scaling will change depending on the microscope
zoom magnification -- the software will automatically adjust
for changes in the zoom.

e Drill Z Sensor - a sensor mounted on the drill holder that is
used to sense when the drill has contacted a surface. This
sensor is used to determine the location of the sample
surface, and the location of the drill bit tip.

e Drill XY Offset - because the drill is mounted off to the side of
the microscope, the XY stages need to move a certain
amount to adjust for the difference between the centerline
of the drill and the center of the microscope view. This
distance is used to position the sample for running scans.

Each of these sensors and procedures are explained in detail in the
following sections.

For the on-screen live video to display the correct magnification, the
position of the zoom knob on the microscope must be known. There is a
sensor embedded in the microscope that is used by the program to
determine the zoom position -- for this sensor to be accurate it must be
calibrated. This is normally done at the factory, but you may want to verify
it in case anything moved during shipment. Once done, the calibration
should not need to be repeated.

The calibration is done by clicking on the appropriate button in the Setup
Checklist, or selecting View —> Calibrate Zoom.

19



Focal Plane

Interactions

Video Screen

Calibrate the Zoom
Sensor First

After calibrating the zoom, the video screen should also be calibrated.
See Video Calibration Procedure on page 21.

To position your sample under the microscope so it is in focus, the
program must know the thickness of the sample, and the Z position of the
microscope focal plane. For calibration purposes, the focal plane is
defined as the Z position where the top surface of the sample plate is in
best focus (with no sample loaded). For best results, the focal plane
should be determined with maximum zoom, when the depth of focus is
the smallest.

This figure shows the sample plate positioned at the focal plane:

N\

| -

Microscope Focus

Top of Sample Plate

[
Figure 4-5: Focal Plane

To set the focal plane, click on the appropriate button in the Setup
Checklist, or Select Position - Microscope Focal Plane.

When measuring the focal plane, the software waits for you to focus the
image, and then records the current Z position.

Since the microscope video is off-axis, the distance between the drill axis
and the video axis changes as the Z stage moves up and down. Thus, the
Drill XY Offset is defined as the distance from the drill axis to the
microscope video axis, at the focal plane of the microscope. When scan
patterns are defined in the software (by drawing on the screen with the
mouse), it is important that the sample be positioned at the focal plane,
otherwise, the XY Offset may not be right and the scan will not be milled
accurately (there will be a constant offset error).

To accurately place scans and measure distances when viewing the
microscope video, the live video display window must be calibrated. The
drill view video does not need to be calibrated.

Before calibrating the screen, make sure that the zoom sensor has been
calibrated. See Zoom Sensor on page 19 for details.

20
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Video Activate the screen calibration procedure by selecting View - Calibrate
Calibration Screen or by right-clicking on the video window:
Procedure

Screen Calibration Wizard |

Select zaom paozitian:
=

Then prezs Mest.

X .ﬁ.l:n:urtl < Back | Mest

Figure 4-6: Screen Calibration Wizard

This window will guide you through the process of calibrating the video
screen so that the position of the mouse cursor on the screen can be
correlated with the position of the sample and motor stages. Because the
zoom optics does not typically produce a perfectly linear magnification
range, you must do the calibration at all of the preset zoom positions (O,
25, 50, 75 and 100%). The software will interpolate the magnification
when the zoom is set at a value between any of the preset positions.

A metal ruler is normally supplied with each system and is used in the
calibration procedure. Focus the ruler under the microscope and continue
with the following steps.

First, select a zoom position in the Screen Calibration Wizard and then
adjust the zoom knob on the microscope to match the selected value.
Click Next and the software will automatically switch to the "measuring
tool" to measure a distance on the screen.

Without moving the stages click at two different locations on the image in
the video window -- you must know the exact distance between these two
points! The ruler is useful for this procedure because the lines on the ruler
are located a known distance apatrt.

You will get the best results if you click on points that are as far apart on
the video image as possible -- this reduces the error in the calculations
since the measurement is made over a longer distance.

Repeat this procedure for each of the preset zoom positions in the Screen
Calibration Wizard.

21



Drill Z Sensor The drill is mounted on a slide that can move up and down vertically.
There is an electro-optical sensor mounted on the drill slide that can
detect when the drill moves up, such as when the Z-axis is lowered and
the drill contacts a hard surface. In this way, the drill is used as a "sensor
probe" to determine the Sample Thickness and the Drill Tip Position. The
drill must move a finite distance before the sensor can detect the
movement; this distance is set at the factory and is typically about 0.5
mm, but must be calibrated to find the exact value. When measuring the
offset, the software first records the Z position at which the tip is just
making contact with a hard surface, it then moves the Z axis until the
sensor is tripped, and then calculates the difference between the two
positions to determine the offset.

£ Sensor - | |
of
T

fset

Figure 4-7: Drill Z Sensor

The calibration is initiated by clicking on the appropriate button in the
Setup Checklist, or selecting Drill Setup - Calibrate Drill Z Sensor. The
software will then guide you through the steps necessary to do the
calibration.

Note: it is critical that you initially position the drill so that it is just touching
the surface. You can even install the bit in upside down, so that the blunt
end is protruding from the drill chuck, and then move the Z-axis down until
the bit is just touching a hard surface (an extra sample plate placed on top
of the original plate works well). Try sliding the extra plate around and feel
for when the bit touches it.

Interactions This is probably the most critical calibration parameter because it is
used by the software when measuring the Drill Tip Position and the
Sample Thickness. Take your time and be very careful when performing
this procedure -- you may even want to repeat it a few times and make
sure you get the same results (within a micron or two) each time. If the Z
Sensor Offset is changed, the Drill Tip Position and Sample Thickness
measurements should be updated as well.
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Drill XY Offset

Interactions

The Drill XY Offset is defined as the distance between the drill vertical
axis and the microscope video vertical axis at the focal plane. When
defining this distance, it is important that the microscope video be focused
as accurately as possible. For that reason, it is suggested that the
microscope is set at maximum zoom, to reduce the depth of focus and
minimize any area of uncertainty when determining the best focus. The
software determines the XY Offset by tracking the distance the stages
have moved during the measurement procedure — be sure to follow the

procedure carefully.

Hicroscope
Focal Plane

l

Or-i Ll HY Offset —|

Figure 4-8: Drill XY Offset

Click on the appropriate button in the Setup Checklist, or select Drill Setup
—>Calibrate Drill XY Offset to initiate the calibration procedure. The
program will then guide you through the necessary steps.

The software uses the XY Offset to position the drill at the proper location
when running mill scan patterns. Since the XY Offset is defined relative to
the Microscope Focal Plane, the XY Offset should be double-checked
anytime the focal plane has changed.
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Running the

Software
Video Window

Selecting Drill or
Microscope Video

Zooming the
Microscope Video

The main program window is dominated by the live video display window,
which shows a real-time view of the image from either the video camera
mounted on the microscope, or the camera mounted near the drill. When
viewing the video from the microscope, crosshairs are overlaid on the
video image to designate the drill "aim point". Scan patterns can also be
shown overlaid on the video image. Along the edges of video display are
the stage scrollbars tpat can be usto move the sample around.

Figure 4-9: Live Video Display

You can select between two different video cameras -- the microscope
video or the drill video by using the view selection buttons located above

the video window:
B B o

Ol | Scope
Figure 4-10: Scope icon

When you select either view, the motorized sample slide is moved to
place the sample in position under the selected camera.

The magnification of the microscope video is adjusted by turning the
zoom knobs on the microscope. This changes the magnification by
moving optics inside the microscope. There is a sensor inside the
microscope so that the software can read the position of the zoom knobs,
and have the video display match the video. The zoom sensor and the
video screen must be calibrated when the system is first set up to insure
proper operation. See Video Calibration Procedure on page 21 for details.
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Panning and
Zooming the Drill
Video

The drill video camera is not equipped with a zoom lens, but using the
image processing capabilities of the video board it is possible to
electronically zoom the video. You can adjust the drill video zoom by
right-clicking in the video window and selecting the Zoom and Pan menu.

Pan and Zoom Yideo |

Pan and zoom the live videa display 7
Uze scroll bars Yideo Zoom——
ta pan video Lo 4
HiEw. v 2%
i 4H
: I I L4 I -

Figure 4-11: Pan and Zoom Video screen

You can select a zoom level of 1X, 2X or 4X, and use the pan controls to
center the view.

Note that at the 4X zoom level, the quality of the video image will be
degraded due to the effects of the electronic zoom.

Adjusting the
Video and
Crosshair Display

Saving a Video
Image

Freezing the Video
Image

You can adjust properties such as the brightness of the video display, the
colors used to display the cursors and many other properties from the
View->Video Properties menu, or by right-clicking the video image.

You can save a copy of the current video image in a file that can be
imported into a graphics or word-processing program, or saved for
archival purposes. Select File > Save Video Image, enter a file name and
click OK. Files can be saved in Windows bitmap, TIFF or Targa format.
Each image is saved at full resolution to obtain the best quality, so the
files can be quite large (about 900KB per image for the bitmap format).

Sometimes you need to show a stationary image on the video display,
such as when capturing a screen image of the program. Because of the
way the live video hardware works, if live video is being displayed when
you try and capture a screen image, you will not see any live video in the
resulting image. If you select View >Freeze Video before capturing the
screen image, the live video display will be captured on the screen and
will show up in the screen image.
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Display Options

Crosshair Options

Pattern Options

Video Display
Properties

The Display Options are accessed from

the View menu, or by right-

clicking the video window. From here you can customize the appearance

of graphics drawn on the video window.

Dizplay Options E3 |

LCrogghair

Colaor: -

Wisible [
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Selected Calar: I | x Cancel |

Vizsble |

Figure 4-12: Display Options screen

Here you can adjust the color of the crosshairs and turn them on and off.
Choose a color that contrasts with the sample you are viewing to make

the crosshairs easier to see.

Here you can adjust the color of the scan patterns drawn on the screen
and turn them on and off. Choose a color that contrasts with the sample
you are viewing to make the patterns easier to see. You also change the

width of the line that is used to draw the
make the patterns easier to see.

patterns -- setting it wider will

You can access the Video Display Properties by right-clicking the video

window, or from View - Video Properties

Adjust Yideo |

Hue S aturation

Brightness | Conbrast

40

- ~ | |
;.-ﬁ Advanced... |
& OK X Cancel |
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Hue
Saturation

Brightness

Contrast
Advanced...

Light Source
Controls

Light Source
Selector

Illumination
Control

Using the
Stages

Adjusts the red-green color balance of the live video image.

Adjusts the color saturation of the live video image. Turning the saturation
all the way down results in a black and white image.

Adjusts the brightness of the live video image. Setting this too high can
reduce the image quality and produce a "grainy” image.

Adjusts the contrast of the live video image.
Brings up the Advanced Video Properties box.

The light control toolbar is location in the upper-left area of the main
window and is used to control illumination of the sample in the video
window.

e P

Coax

Figure 4-14: Use this slider to control illumination

Click to toggle through the available light sources. Alternately, you can
click on the down arrow to display a drop-down menu of light sources.

g -
Ring
Figure 4-15: Click to toggle through light sources

The system is normally equipped with the following sources:

o Reflected - light comes from a set of bulbs or fibers installed
in a circle around the imaging objective and comes down
onto the sample at an angle, then bounces back up into
the camera. Good for seeing surface structure and texture
and uniformly illuminating the sample, but may have some
shadows.

¢ Transmitted - light shines up from underneath the sample,
through the sample and up into the camera. This only
works if the sample is at least partially transparent and is
mounted on a transparent substrate.

This is used to set the light level for the selected source. Move the slider
bar to the right to increase the light level.

You can position the microscope over your sample and focus on the
sample surface by controlling three motorized stages that move in the X,
Y, and Z axes. When running scans, the software controls all stage
movements; otherwise you can control the stage movements by using the
Stage Scroll Bars, much like the scroll bars in a word processing
program.

If your computer is equipped with a joystick, you can use the joystick to
move the stages as well. See Using a Joystick on page 52 in the
Appendix for detalils.
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Calibrating the

Stages

Stage Scroll Bars

Stage Motion
Multiplier

[

N

S|
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To know the position of the stages, the system must first perform a
calibration procedure on the stages. This is necessary because the stage
position is determined as an offset from the location of a limit switch at the
stage's "home" position, and until the stages are moved to home position
and the limit switch is tripped, the software does not know where the
stages are located.

The calibration procedure performs the following steps:
1. The stage is moved at its maximum speed toward the limit switch.

2. When it hits the limit switch, the stage controller electronics stop the
motor.

3. The software moves the stage away from the limit switch.

4. The software moves the stage towards the limit switch again, this
time at slow speed.

5. When the stage hits the limit switch, the motor is stopped, and the
software resets the internal stage position counter to zero.

If the stages have not been calibrated, the software will prompt you to
calibrate them as soon as you use a feature that requires that the stage
position is known.

Located along the edges of the Video Window, the stage scroll bars are
used to control the movement of the X, Y and Z axis motors to position
the sample in the video window.

The X and Y scroll bars are located along the bottom and right sides of
the video window respectively, while the Z scroll bar appears in the upper
left portion of the video window.

Each scroll bar is made up of several buttons:

Click to move the stage 1 step in the indicated direction. The step size
depends on the stage properties and the stage motion multiplier.

Click and hold to move the stage in the indicated direction. The speed at
which the stage moves depends on the stage settings and the stage
motion multiplier.

Click to stop all the stages.

Click and drag the scroll bar "thumb" to move the stages to the desired
position. As you move the scroll thumb, a small window pops up showing
you how far (in mm) the stages will move once you let go of the mouse
button.

Right-click on a scroll bar to change the Stage Motion Multiplier or to edit
the Stage Motion Properties (described in the next section).

When you right-click on a stage scroll bar, you can select a scale factor
that is applied to the stage motion parameters when moving the stages
manually using the scroll bars or when using the joystick. The scale factor
is applied to both the stage step size and the stage jog speed. This allows
you to quickly change the jog and step rates without having to edit the
stage properties and type in a value.

Example If the stage Jog Speed is set to 100 pm/sec, and the Multiplier is set to
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Stage Motion
Properties

Step Size

Jog Speed

Stage Position
Toolbar

Position Button

XYZ Position
Display

Joystick Button

10X, then the stages will move at 1000 um/sec when the Jog button is
held down.

This is where you set how fast and far the stages move in response to the
stage scroll bars. Right click the Stage scroll bars and select Properties to
access the properties window or click Position -->XY Stage Properties or Z
Stage Properties menus.

The X and Y stages use the same settings, but the Z settings are set
separately. In other words, right-clicking on either the X or Y scroll bars
will set the properties for both stages, but you must right-click on the Z
scroll bar to change its settings.

*.Y Motion Properties |

Step Size: |5 pm
Jog Speed: IEEU i ses

X Cancel |

Figure 4-16: X,Y Motion Properties box

Sets the amount that the stage moves each time the stage step button is
pressed.

Note that the step size is multiplied by the current stage
motion multiplier.

Sets the speed that the stage moves at each time the jog button is
pressed.

Note that the jog speed is multiplied by the current stage
motion scaler.

Displays the current XYZ stage positions, lets you save and recall
positions and allows you to change the options for the joystick control.
This is located above the live video display on the main window.

Pasitior: |41.41E | 8172 |24.324 i %

Figure 4-17: Stage Position Toolbar

Brings up the Stage Position dialog box -- from there you can save and
recall stage positions, and define a new position.

Displays the current position of the X, Y and Z stages in millimeters. If the
stages have not been calibrated (homed), then a "?" is displayed. See
Calibrating the Stages on page 28 for more info.

Enables joystick control of the stage if the computer is so equipped. (The
joystick and Windows-compatible driver required are not supplied by New
Wave Research.) See Using a Joystick on page 52 in the Appendix.
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Recalling and Clicking Stage Position Toolbar = Position brings up the Stage Position

Saving Stage dialog box. From here you can save and recall stage positions, as well as

Positions move to any specified XYZ position. The Stage Position box has two
sections, one for defining and saving positions and the other for recalling
saved positions.

Defining a New Used to move to a specific set of coordinates, or to save the current

Position position for later use.
Stage Positon |

RPecall Position  Define Mew Position

Enter coordinates of new
pogition o move to,

= IEDDDD.DD prn
e ||:|.|:||:| LAY
= ||:|.|:||:| pm

£ Save Az

x Cancel |

Figure 4-18: Stage Position-Define New Position

When this window is first displayed, the coordinates default to the current
stage positions. Enter the coordinates to move the stages to, and then
click OK. Click Save As. if you want to store this position for later use.
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Recalling a Saved
Position

Position Files

Using the Sample
Map

Choose one of the previously saved positions from the list, then press OK
to move the stages to that position. If you click on an item in the list of
saved positions, a small "hint window" will pop up showing the XYZ
positions corresponding to that item. Click OK, and the stages will move
to the specified position.

Stage Position |

Fiecall Position I Define Mew Position I

Select poztion from lizt;

]

x Cancel

Figure 4-19: Stage Position - Recall Position screen

Positions are saved as ASCII text files with a .POS extension in the Data
folder. POS files can be edited with any text editor.

A sample map is a composite image of the sample, made up by "stitching
together" smaller images to produce a mosaic image of a large area of
the sample. It is a powerful way to view and navigate a sample by giving
you a "birds-eye" view of the sample, and allowing you to click on a
location and have the stages automatically move to that location.

The sample map is displayed on the lower-left side of the main screen -- if
no sample map is currently defined, the display area will be blank.

If a map is defined, clicking on the map image will move the stages and
center the crosshairs on that location.

Click Sample Map to bring up the Sample Map management window.

Right-click over the sample map display and select the Erase Map
menu to clear out the map display.
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Creating Sample
Maps

Map Positioning
Box

Map Location

Sample maps are built in the Sample Map window. Click View - Sample
Map or click on the Sample Map button above the map display area in the
main window.
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Figure 4-20: Sample Map

The sample map window is where you define how large an area of the
sample to map, and where that area is located. You can also save and
recall existing maps to and from files on the computer.

Displayed in the upper left area of the Sample Map box are a set of
rectangular boxes -- a large area shown in gray, with a smaller blue box
inside it. The gray area represents the total area of the range of motion of
the XY stages. The smaller blue box represents the current size and
location of the area to be mapped. You can drag the blue box around with
the mouse to change the location of the sample map, or select one of the
predefined map locations described below.

The map location is defined by specifying where the map should be
centered. There are three options:

o Centered on the current stage position - the map will be
centered at the current stage position, subject to the
constraint that no part of the map can be outside the range
of travel for the stages. In the case where a map would be
outside the allowed area, the software puts the map as
close to the outer edge of the sample as possible.

e Centered within the Sample Area - the map will be centered
within the area of the total travel of the XY stages. For
example, if the stages have 50 mm of travel, the map will
be centered at (25, 25).

e User Defined Location - the map is centered at some user
defined location. You can manually enter values, or drag
the blue box in the map preview to the desired location.
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Map Size

Making a Map

Saving aMap in a
File

The size of the sample map is defined in terms of how many images wide
and tall it is. The more images that are used to make the map, the larger
the area covered will be.

Note that the current video zoom setting will affect how
large each of the images are -- it is recommended that
you make sample maps with the zoom set to 0% so as to
cover as large an area as possible.

As you change the map size, you will see an estimate of how long it will
take to make the map displayed in the status line at the bottom of the
window.

Before making a map, make sure the size and location of the map are
set, the sample is in focus and the illumination level is sufficient,
otherwise you will not get a good image. When ready, click Make and wait
for the process to complete. While the process is underway, you can click
Make again (its caption will have changed to Stop) to stop the process.
The status line at the bottom of the window will show the progress of the
map build.

Once the process has completed, you can click on the map to move the
stages to a location. Click OK to close the map window and the map will
be displayed in the sample map box on the main window.

Sample maps can be saved for reuse. By default, they are saved in the
Maps subdirectory of the folder where the program was installed (usually
C:/Program Files/Merchantek EO/Laser Ablation/Maps). A sample map is
saved as a Windows bitmap file (.BMP) and can be pulled into most
graphics and word-processing programs.

NOTE: Sample maps contain position information encoded into the first few
pixels of the image, so if you view the image with another program, you
may see some strange colors in the first few pixels -- don't edit these pixels
or you will not be able to recall the map into the ablation software.

Recalling a Map A map can be recalled and reused. The map is restored at the same X, Y

stage position as when it was made, so it is important that the sample be
loaded into the sample chamber in the same position as when the map
was made.
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Installing Drill In order to accurately set the depth to drill a scan, the system must know
Bits the position of the tip of the drill bit. This is done by using the drill Z
sensor to determine the Z position of the drill bit.

Click on the appropriate button in the Setup Checklist, the Setup Toolbar or
click Drill Setup - Load a New Drill Bit to initiate the load procedure. The
program will then guide you through the procedure.

Mounting a Sample In order to mill a scan on a sample, the samples must be securely
mounted to the round sample plate. Typically this is done by removing the
plate from the MicroMill Sampling System, melting some wax on it,
placing the sample on the melted wax then allowing the wax to cool and
harden. The plate can be placed on a hot plate to warm it up. If placed on
an aluminum surface or metal table it will cool rapidly.

The sample can also be affixed with hot-glue, double-sticky tape, or any
other type of suitable adhesive.

Defining the The thickness of the sample is defined as the Z distance from the top
Sample Thickness surface of the sample holder plate to the top surface of the sample. This
value is used by the program to place the surface of the sample at the
focus of the microscopel/video, and to position the drill at the proper depth
when milling. Anytime a new sample is loaded, the thickness must be
specified. The surface can be defined two ways:
(1) as a flat surface (one that is parallel to the sample mounting plate), or
(2) as a tilted surface that is tilted at an angle with respect to the sample plate
surface.

Flat Surface A flat surface will have the same Z coordinate (height) at any location on
the sample, so all milling will use the same Z position. The height is
measured by simply bringing the bit down until it contacts the surface and
trips the Z axis sensor.

The program will remember the last value that was entered, so you can
accept the default value if you have not changed the sample.

N\

Focal Plane -+ —+——
?
Sample

Thicknesz
|

Figure 4-21: Sample Thickness

To specify a thickness, click on the appropriate button in the Setup
Checklist, or select Position ->Sample Thickness - Flat Surface. The program
will allow you to either edit or use the default value, or measure a new
value. The MicroMill Sampling System can measure the thickness by
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Titled Sample
Surface

Using the Drill

Drill Speed Control

Drill On/Off Button

Interlock Indicator

Safety
Interlocks

positioning the sample under the drill and moving the drill down until the
drill Z sensor is activated.

For a tilted surface, the height of the sample varies depending on the XY
location. The software models a tilted surface as a plane, tilted about the
X and Y axes. Three points are needed to define the plane, and this is
done by placing three reference marks on the sample, and then
measuring the height of the sample at each point. Click Position - Sample
Thickness > Tilted Surface and the software will guide you through the
process.

When not running scans, you can manually run the drill by using the Drill
Control Toolbar. From the toolbar, you can set the drill speed and turn it
on and off. When scans are being run, the system controls the drill for
you, using the settings specified by the scan properties.

Crill Speed
|—P—5 ve Boa W

Figure 4-22: Defining the drill speed

Sets the speed of the drill. The drill speed is set in percentage of its
maximum speed, 0% = slowest, 100% = fastest. This control is only
active while manually drilling. When running scans, the drill speed is
controlled by the scan pattern properties.

Turns the drill on and off when in manual mode. When running scans, the
drill is automatically controlled.

Indicator that lights up red when one of the safety interlocks is tripped.
Click on the indicator to display the Interlock Failure Window to see more
detailed information.

Because the drill and motorized stages can be dangerous to the operator
or can be damaged if not operated under proper conditions, the MicroMill
Sampling System is equipped with a set of safety interlocks. The software
continuously monitors all interlocks and will take the appropriate action
when an interlock is tripped. When this happens, an Interlock indicator on
the Drill Control toolbar will turn red -- click on the indicator to bring up the
Interlock Failure window:
Never defeat an interlock and continue working with the MicroMill
Sampling System. Defeating any safety interlock and continuing to
operate this tool may cause severe personal injury or may damage the
system.

Interlock Faiurel B |

Safety interock
status ?
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@ Sample Slide

@ Stop Button

@ Drill Dverload
Figure 4-23: Failed Interlock screen

35



Sample Slide
Interlock

Drill Overload
Interlock

Drill Z Sensor
Interlock

Stop Button
Interlock

Placing Scans

The indicator lights on the left will light up to show which interlocks have
been tripped. When an interlock is tripped, the software will automatically
take the appropriate action to insure that the system remains in a safe
condition -- often this means shutting down the drill, or stopping the
stages. Following is a list of the interlocks with a description of why the
interlock is tripped and how the drill will respond:

Cause: The sliding stage that the sample is mounted on is not in the Drill
position (all the way to the left). It is normal for this interlock to be
activated when the sample is in the microscope view position.

Result: The drill is disabled. The video view is switched to the
microscope when the slide is not in the Drill position, and is switched back
to the drill video when the slide is returned to the Dirill position.

Cause: The drill motor current limit has been exceeded.
Result: The drill is disabled.

Cause: The drill has moved up (vertically) due to pressure on the bit.
Result: The drill is disabled.

Cause: The Stop button (on the front of the MicroMill Sampling System)
has been pressed.

Result: The drill and stages are disabled.

Click Interlock Failure - Stop indicator to clear the indicator and re-enable
the stages and drill.

Once the system is calibrated, a sample is mounted and the sample
thickness is defined, you are ready to place scans.
1) Position a sample under the microscope by selecting the microscope
video view -- the sample slider should be all the way to the right if it isn't
already:

Figure 4-24: Placing scans

2) Select the proper tool from the scan toolbar. You can right-click on
the scan toolbar button and set the default properties (speed,
depth etc.) for the patterns you are about to place.

3) Click on the video image of the sample and define the endpoints of
the scan. As you place scans, they are added to the scan
pattern list, which is displayed just to the left of the video image.
You can right-click on any pattern in the list to edit its properties,
or press the Properties button below the list.

Some scans, such as lines and rasters, require you to define multiple
endpoints. You can press Escape or right mouse to end placing a scan -- if
enough endpoints have been defined, then the scan is added to the list.

Line scans can have a virtually unlimited number of endpoints -- each set
of endpoints defines a line segment. Every time you click, a new endpoint
is defined; press Escape, or right click to end the current line.
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Scan Toolbar

Scan Pattern Tool

Setting the
Default Scan
Properties

Selection Tool

Centering Tool

Measuring Tool

The Scan Toolbar contains the "tools" you use to place and manipulate
scans. When a tool is selected, its corresponding button will appear
depressed on the toolbar, and the mouse cursor will change to reflect the
tool selection as well. (The mouse cursor will only be changed while the
mouse is over the live video window).

ok B~ 18 7|

Figure 4-25: Scan Toolbar

Selects which type of pattern will be created. You select the type of
pattern by clicking on the small down arrow and choosing from the list
that appears. The following scan patterns are available:
Raster Scan - a rectangular area with rows of horizontal lines through it. The
vertical spacing between the lines is adjustable. During milling, the drill will
follow the path of the lines.

Grid of Spots - a rectangular area with sets of spots arranged in rows and
columns. The spacing between the rows and columns is adjustable.
During milling, the drill will move to each spot location and drill for a
specified amount of time.

Line - one of more connected line segments.

Line of Spots - spots placed along a line segment at a specified spacing.
During milling, the drill will move to each spot location and drill for a
specified amount of time.

Spot - a single spot location. The drill will move to the spot and drill for the
specified amount of time.

{B Reference Point - used to mark a reference location on the sample. No milling

will take place at the reference point. Reference points are used primarily
for locating landmarks when doing recoordination. See Recoordinating
Scan Positions on page 41 for details.

Right-click Scan Pattern tool to edit the default properties for new scans --
any new scans you lay down will then use these properties.

Used to select a pattern or a group of patterns for editing. You can also
use the selection tool to click and drag entire patterns or just single
endpoints. This tool has several different modes that are explained in
detail in Selecting and Dragging Scans on page 38. When a scan is
selected it is drawn in a different color on the video window, and is shown
highlighted in the Scan Pattern List.

Used to center a location on the video screen. Click on a location in the
video window and the stages will move to bring that point to the center of
the window, aligned with the crosshairs.

Used to measure distances on the screen. Click on two locations in the
video window and the distance between them will be shown in the status
line at the bottom of the screen.
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Selecting and After you have placed a scan, you can delete it, cut and paste it or drag it

Dragging Scans to a new position using Scan Toolbar - Scan Selection tool. The selection
tool is quite powerful and has several modes of operation -- the mouse
cursor will change to indicate which mode is active. Its behavior is based
on the way similar tools behave in graphics and CAD programs.

When a scan is selected, it is drawn on the video window in a different
color, and is highlighted in the Scan Patter List on the left side of the

screen.

Selecting an Entire There are two ways to select an entire scan -- you can click directly on

Scan the scan (anywhere but at an endpoint), or you can click to define a
rectangle around an area to select any patterns that are completely inside
that area.

If you want to select more than one scan, SHIFT + click-- any patterns
that are already selected will remain so, and any newly selected patterns
will be highlighted. If you do not hold down the SHIFT key, any patterns
previously selected will be unselected and only the newly selected
patterns will be highlighted.

Dragging a Scan Click and drag a scans borderline (anywhere BUT an endpoint) to a new
position to move the scan. The cursor will change to a hand as you are
dragging the scan. Holding the Shift key and dragging will choose all the
scans.

When scans are dragged, only their X and Y coordinates are changed,
the Z positions stay the same.

Note that you can also use the Translate/Rotate menu (accessed from the
Scan Pattern List) to move scans around by a specific amount.

Dragging an Click and drag an endpoint to a new position.

Endpoint When you drag an endpoint, its XY position is changed to the new
position, and the Z coordinate is changed to the current Z axis position.
This allows you to move endpoints "up and down" in Z by moving the Z
axis up or down and dragging the endpoint.

You can also click Scan Pattern List - Edit Endpoints menu to change the
positions of an endpoint.
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Cut, Copy and
Paste Scans

Copy Scans

Cut (Delete) Scans

Paste Scans

Saving and
Recalling Scans

File Formats

Saving Files

Recalling Files

Recoordinating
Scan Positions

Manipulating
Scans

If you have a scan selected, right-click in the video window to access the
Cut, Copy and Paste menus.

Right-click in the video window and select the Copy menu to put a copy of
all selected scan patterns into the copy buffer. No scans are removed
from the display.

Cut will delete all selected scans from the display and place them in the
copy buffer.

Paste will place a copy of each scan in the copy buffer on the display, at
the current mouse position. You can use paste multiple times to make as
many copies of a scan (or scans) as you wish -- the copy buffer is not
emptied until the program is terminated, so once a pattern is in the buffer,
it stays there.

Scans can be saved in files for archival use and reuse. You can also
recall saved scans and import scans from other file formats.

Scans can be saved and recalled in two formats:

e MicroMill Experiments Files ((MME) - a binary file format that
is small, fast and saves all the scan locations and
parameters. This format cannot be read by other
programs, but is the most efficient way to save scans.

e ASCII Text Files - a special text format which can save the
type and location of the scans, but not the scan properties.
ASCI! files can be edited with most any word processing
program or editor. See the ASCII File Format on page 50
in the Appendix for details.

In addition, scans can be imported from DXF files.

Click File > Save Experiment to save scans. You can choose to save files
in either MME or ASCII format. By default, experiments are saved in the
C:/Program Files/Merchantek EO/MicroMill/Data directory.

Select File > Open Experiment to read in scans from a file. Any scans read
in will be added to those already defined, thus allowing you to "merge"
scans saved in multiple files. If you want to get rid of all currently defined
scans, select New Experiment from the File menu.

See Recoordinating Scan Positions on page 39 for details on how to
make imported data line match up with the sample.

Click Options (located just below the Scan Patterns list) to access a set of
menus that can be used to move and duplicate scans.
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Duplicating Scans

Translating and
Rotating Scans

Editing Endpoints

Interpolating
Between Scans

Interpolating
Between Scans

Click Duplicate Scans to make multiple copies of each selected scan
pattern (selected scans are highlighted in the list and on the video
window). You can specify how many copies to make, and how far apart to
space them. Each copy will be offset from the original scan by the
specified distance.

Click Translate/Rotate Scans to move all selected scans by a specified
distance, or rotate them a certain angle. You can specify whether to do
the translation first or the rotation first.

Click Edit Endpoints to edit the XYZ coordinates of the individual endpoints
of a scan. A small calculator icon appears in the lower-left corner of the
Edit Endpoints dialog box -- click on a coordinate value, then click on the
calculator icon to activate a pop-up calculator window that lets you easily
perform mathematical operations on the value. Click the check mark on
the calculator and the result will be entered in the endpoint coordinate.
Another way of creating scans is to select two existing line scans and
have the software generate a set of new scans, equally spaced between
the original scans. This is explained in detail in the next section.

You can define a set of new scans which are equally spaced between two
sets of line scans by selecting two line scan patterns from the Scan
Pattern List, and then right-click, or click Options - Interpolate Between
Scans menu. The two selected scans must be line scans with the same
number of segments. The following screen will be displayed:

Interpolate Between Scans |

Insert Scans Between Bdisting Scans ?

—Mumber of Scans [nserted

Mumber of Scan: 4  Spacing Between -

— Yalume Removed

Depth i
a0 T

[ Yolume removed by each scan line: 00607 mn
B Total volume removed: 0018 mine

x Cancel |

Figure 4-26: Interpolate Between Scans
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Number and
Spacing of
Interpolated Scans

Depth of
Interpolated Scans

Volume Removed

Recoordinating
Scans

There are two ways of defining how many scan lines are generated when
interpolating between existing scans. You can either specify how many
scans are to be made, or you can specify the maximum spacing between
the scans, in which case the program will then calculate the number of
scans for you.

Sets the drilling depth for the interpolated scans. It also sets the depth of
the original scans (the ones enclosing the interpolated scans). This
number will affect the calculation of the volume removed.

The volume removed calculation assumes that the interpolation function
is used to remove all of the material between the two original scan lines to
the depth of those lines. Based on this assumption, two numbers are
displayed:

¢ Volume Removed by each Scan Line — This calculation divides
the total volume between the original two scan lines by the total
number of scan lines programmed and does not take into
account overlap between adjacent scan lines. It is a function of
scan geometry, drill depth and the interpolated line spacing.

e Total Volume Removed — This calculation displays the total
volume between the original two scan lines. It is a function of
scan geometry and drill depth. The actual volume removed will
exceed the calculated figure by the volume of one scan line since
the calculation doesn't take into account the width of the drill bit.

In both of these calculations, factors like the shape and size of the drill bit,
and overlap between scans are not considered.

Yaolume Removed

Milling Depth g |
1] LM -

B Total volume removed: |- re— |
i

O Wolume removed by each scan line:
Fii

Figure 4-27: Volume Removed

Often when recalling saved scans, or importing scans from another
source, you will want to "recoordinate” the data so that it matches up with
the proper locations on the sample.

Scan Recoordination allows you to recall previously saved scan patterns
and position them in their original location on the sample surface, even if
the sample has been rotated or mounted in a different location. Recalled
files can be either MicroMill Experiment files ((MME) or ASCII format files.
Recoordination relies on reference points that must be included in the file
being recalled. In addition, you must be able to move the stages and
center the crosshairs on the locations on the sample where the reference
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Two Dimensional
(2D)
Recoordination
Three Dimensional
(3D)
Recoordination

The Scan Pattern
List

points where originally placed. For this reason, you should place your
reference points on easily recognizable "landmarks" or features on the
sample.

The recoordination procedure will prompt you to move the crosshairs to
the landmark locations on the sample that corresponds to each of the
reference points. Then by comparing the original location of the reference
points (as stored in the file) with the new location of the reference points,
the scans can be "recoordinated” and moved to their new locations.
There are two types of recoordination are supported - 2D and 3D.

2D recoordination will correct for any rotation and/or translation of the
sample since the points were originally saved. Only 2 reference points are
required.

3D recoordination will correct for rotation, translation AND tilting of the
sample. It requires 3 reference points, and the three points must NOT be
collinear (in a line). It also requires that you focus precisely on each
location in order to accurately determine the Z position -- for this reason it
is recommended that you set the video view to maximum zoom when
focusing since the depth of focus is less when zoomed in.

Located on the left side of the main program window, the Scan Pattern
List displays a listing of all the currently defined patterns. Below the list
are a set of buttons that are used to access various options for
manipulating the scans

Scan Patterns:

= Raster #1
— Line #1

Move Tu:ul F"ru:upertiesl Options |

2 Patterns
Total Time: 0:00:38

Figure 4-28: Scan Patterns Screen

Each scan is shown in the list with a small icon next to it indicating the
type of the scan pattern (raster, line etc.). Each scan is also labeled with a
name and number - you can rename any of the scans by right-clicking on
the scan list and selecting Rename.

Following are actions you can perform:

e Click on an item to select it. The item will be highlighted in the
list, and it will be displayed in a different color in the video
window.

¢ Hold down the SHIFT key and click on an item to select a
range of patterns.

e Hold down the CTRL key and click the individual pattern(s)
you want to select.
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Move To

Properties Button

Options Button

Scan Properties

e Press Delete to delete the selected patterns.
¢ Right click, or click Options button to access the Scan Pattern
Options menu for the selected patterns.

This will move the stages so that the crosshairs are centered on the
selected pattern. If more than one pattern is selected in the list, then the
stages are moved to the first selected one.

This allows access to the pattern properties edit box -- from here you can
set the scan parameters for the selected scan or scans. Parameters such
as the stage speed, the output level and spot size all set from here. See
Setting the Default Scan Properties on page 37 for more details.
Displays a menu of options for manipulating the selected pattern(s).
There are options for duplicating scans, translating/rotating scans and
more.

You can access the Scan Properties edit box by right-clicking on the Scan
Pattern List box and selecting Properties, or clicking Properties (located
underneath the Pattern List). From here you set the parameters that will
be used when running scans. Each individual scan pattern has its own
copy of the scan properties, so you can have different settings for each

scan.
Pattern Properties - Gnd #1 |
Raszter Spacing. 4 Gnd Spacing: a ?
|1EIEIEI.EI LM I'IEIEIEI.EI LT g

—Scan Setting
FPaszes: - Depth/Pazs &
|1 - ] LU e
Diill Speed: 4 Dwell Time & Intersite Paus 4
IED.EI AR I & IEC - I & IEC -

[V Apply to Al Selected Patterns X Cancel |

Figure 4-29: Pattern Properties - Grid #1

The exact options that are shown in the properties box depends on the
type of scan selected -- for instance, Raster Spacing only applies to raster
scans.
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Grid Spacing,
Raster Spacing

Number of Passes,
Depth per Pass

Scan Speed
Dwell Time
Drill Speed
Applying
Properties to

Multiple Scan
Patterns

Applies to Rasters, Grid of Spots and Line of Spots. When setting the
properties for a Raster or a Grid of Spots, you can adjust the Y axis
spacing between rows of spots or lines by changing the raster spacing. If
you are setting the properties for a Grid of Spots, or a Line of Spots, then
you can adjust the X axis spacing between spots with the Grid Spacing
property. Changing the spacing will change the number of lines or spots
that will be milled.

Sets how many times the drill will traverse over the pattern. If set to more
than one, the drill will reverse when the drill and traverse back over the
pattern in the opposite direction. If the Depth per Pass setting is not O
(zero), then the Z axis will also be moved down by the specified amount
at the end of each pass. This is useful for "drilling" down into a sample by
removing a layer of material on each pass.

Applies to Rasters and Line scans only. Sets the speed at which the
stages will move while milling.

Applies to Spots, Grid of Spots and Line of Spots only. Sets how long in
seconds the drill will be on at each spot.

The sets the drill speed that will be used when running the scan. You may
need to experiment with different drill and scan speeds to find out what
works best for a given material.

If more than one scan is selected in the Scan Pattern List, then you can
apply the current scan properties to ALL the selected scans by checking
the Apply to All Selected Scans box. All the current scan properties will then
be copied to all the selected scans.
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Running Scans

Patterns to Run

Enable Drill During
Scans

Run and Abort
Buttons

Once a set of scan patterns are placed, you can click Run Scans to start a
sample run. While scans are being run, the stages and the drill are under
computer control and will use the parameters that you've set up in the
scan properties. The system will continue to monitor the safety interlocks,
so should one be tripped, the scan run will be aborted and the drill and
stages will be shut down. You can also press the Stop button on the front
of the MicroMill Sampling System at any time to shut down the drill and
abort a scan.

When you click Run Scans, a dialog box will appear with a set of options
for controlling the scan run:

fun eans 7

o« All Pattems
" Selected Fatiemsz Only

Tatd Paltetns: 3
Selected Paltems: 2

"Pﬂm Ew

The zampls stane zhider mugt be nhe
[l position fo mam scans.

Figure 4-30: Run Experiments Screen

You can choose to run all defined patterns, or only the ones which are
selected (selected patterns are drawn on the screen in a different color
and are highlighted in the Scan Pattern List). See Selecting and Dragging
Scans on page 38 for more details.

Check this box to enable running the drill when running scans. If this box
is unchecked, then the system will go through all the stage movements
when running the scans, but the drill will remain inactive. This is useful for
double-checking the scan setups before actually milling.

Click Run to start a sample run, click Abort to stop. While a run is in
progress you will be unable to use the software to control the drill or
stages, and if a joystick control is installed, it will be disabled. Once the
sample run is complete, or you end it by pressing the Abort button, control
will be returned to you.
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There are no Maintenance or Troubleshooting instructions.
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ASCII File Format

The ASCII file format is useful for importing scan positions to and from
other programs, such as spreadsheets or digitizers. ASCII files only store
the type and position information of the scans -- the scan properties are
not stored, so you will need to set those manually.

Note: When importing ASCII files, the current default scan settings are
used. See Scan Toolbar for instructions on setting the default properties.

Format Details

The file format consists of multiple lines of ASCII text, each line
terminated with a carriage return and/or line feed character. The file can
contain data on many different scans; each scan is defined by a header
line, and then is followed by one or more lines and endpoint data.

<SCAN TYPE HEADER>
X, Y, Z
X, Y, Z

X, Y, Z

Where

SCAN TYPE HEADER - indicates the type of scan.

X, Y, Z - coordinates of endpoints*, separated by commas; all values in
millimeters.

*NOTE: The Z coordinate is optional and need not be present. If no Z is
specified, then the system will use the current Z stage position.

Scan Type
Header

Several different scan types are supported:

Scan Type Description

REF Reference Point, each one has one endpoint.

LINE Line, can have from 2 to 5000 endpoints.

RASTER Raster pattern, each one has 2 endpoints -- the upper-left and
lower-right corners.

SPOTGRID Grid of spots over a rectangular area, each one has 2
endpoints -- the upper-left and lower-right corners.

SPOTLINE Line of spots, has from 2 to 5000 endpoints.

SPOT Single spot, each one has one endpoint.

You do not need to have a header for each new scan. You can define
multiple scans by including more than the normal number of vertices
under one scan header. For instance, by including 4 sets of vertices
under one REF header, 4 separate Reference Points will be defined.
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Table 6-1: Scan line example

Example: The following is an example containing a line scan (with 5 segments with

6 endpoints), a raster, and 2 reference points.

LINE

31.750,12.255

36.496,12.255

36.496,13.217

31.750,13.217

31.750,14.825

36.238,14.825

RASTER
31.492,16.945
36.109,16.945

REF

36.109,16.945
35.000,20.002
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Using a Joystick A joystick can be used to control various parts of the MicroMill Sampling

System
Requirements

System, such as stage motion and illumination level. The joystick can be
configured within the software to customize the joystick controls -- you
can assign different joystick buttons to different actions, and specify what
happens when the joystick is moved.

To use a joystick, it must be connected to the computer system and have
a Windows-compatible driver installed. Joysticks are typically attached to
the computer's game port, but can also be connected to a serial port,
USB or other interface. Refer to your joystick manufacturer's instructions
for information on how to install a joystick.

Note: The software relies on the Windows joystick driver. The joystick must
be installed and calibrated from the Windows control panel or it will not
work properly.

Enabling the
Joystick

Configuring the

Joystick

When the MicroMill Sampling System software recognizes that a joystick
is installed, a button will appear on the Stage Position Toolbar:

Postion: | 41416 | 8172 | 26324 mm @

Figure 6-1: Joystick Recognition

If you do not see this button, the joystick driver is not installed, or the
joystick is not connected properly.

For safety reasons, the MicroMill Sampling System software starts up
with joystick disabled -- you need to explicitly enable it by choosing Stage
Position Toolbar - joystick. The button will appear depressed when the
joystick is enabled.

If you right-click on the joystick button in the stage position toolbar, a
dialog box will appear allowing you to customize the joystick settings:

Jogpeick 3 pud 7
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fichion Action
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Figure 6-2: Joystick Setup Screen
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Joystick XYZ
Axis Setup

Z Axis Action

Joystick
Buttons

If your joystick only has two axes (X and Y), then the Z axis controls will
be disabled. There are two slider bars displayed for each axis:

e Current Position - shows the current position of the joystick
axis.

o Dead Zone - This adjusts the sensitivity of the joystick. If the
Current Position indicator is jittering, then slide this
adjuster to the right until the jitter is eliminated.

The X and Y axes can only be used to control the X and Y stages.
However, the Z axis can be configured to control one of the following:

e Focus - moving the joystick Z axis moves the focus (Z stage)
up and down.

o Light Level - moving the joystick Z axis adjusts the output of
the current active light source.

o Drill Speed - moving the joystick Z axis adjusts the drill speed.

e None - moving the joystick Z axis has no effect.

Up to 8 joystick buttons can be used to control various options. Each
button can be mapped to a different action. The available options are:

¢ Jog Z Down - the Z axis stage (focus) is moved in the down
direction for as long as the button is held down.

e Jog Z Up - the Z axis stage (focus) is moved in the up
direction for as long as the button is held down.

o Dec. Light - the current light source output is decreased for as
long as the button is held down.

e Inc. Light - the current light source output is increased for as
long as the button is held down.

e Drill On/Off - toggles the drill on and off.

o Place Scan - places a scan endpoint at the current crosshair
location. You must have a scan placement tool selected.
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Contact Information

Web: http://www.new-wave.com

USA

New Wave Research, Inc.
48660 Kato Road

Fremont, CA. 94538-7339

Tel: 510-249-1550

Tel: 800-566-1743

Fax: 510-249-1551

Email: Lasers@new-wave.com

Taiwan

New Wave Research G. C. Co., Ltd.
No. 58-3, XingShan Rd.

Neihu Dist., Taipei

114 Taiwan

Tel: 886-2-8792-7585

Fax: 886-2-8792-7584

Email: NewWaveGC@new-wave.com

China

New Wave Research (China) Co., Ltd.
Rm. 1102, 11/F, Jiaxing Mansion,

No. 877, Dongfang Rd.

Shanghai 200122, China

Tel: 86-21-5058-7785

Fax: 86-21-5058-7786

Email: NewWaveCN@new-wave.com
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New Wave Research, KK

5F Chojiya Building, 1-36-4,
Shinjuku-ku, Shinjuku

Tokyo, 160-0022 Japan

Tel: +81-3-3351-0131

Fax: +81-3-3351-0121

Email: NewWaveKK@new-wave.com

Europe

New Wave Research Co., Ltd.

8 Avro Court, Ermine Business Park
Huntingdon, Cambs

England PE29 6XS, UK

Tel: 44-(0)1480 456566

Fax: 44-(0)1480 456545

Email: NewWaveEU@new-wave.com



